10/ HOW TO LOSE YOUR PANTS WITH ETFs
iShares Silver Trust ETF.

For traders with mettle.

For many traders, liquidity is an important part of an overall investment strategy. iShares Silver Trust ETF was created with that in mind. Unlike physical silver, it’s easier to buy and sell — making it an option for investors who seek to maximize returns over the short term. Plus, it’s low-cost, so like other iShares ETFs, it can help you keep more of what you earn.

For details, visit iShares.com/silver

Investing involves risk, including possible loss of principal. The iShares Silver Trust (SLV or the “Trust”) is not an investment company registered under the Investment Company Act of 1940 or a commodity pool for purposes of the Commodity Exchange Act. Shares of SLV are not subject to the same regulatory requirements as mutual funds. Because shares of SLV are intended to reflect the price of the silver held by the Trust, the market price of the shares is subject to fluctuations similar to those affecting silver prices. SLV has filed a registration statement (including a prospectus) with the SEC for the offering to which this communication relates. Before you invest, you should read the prospectus and other documents the Trust has filed with the SEC for more complete information about the issuer and this offering. You may get these documents for free by visiting www.iShares.com or EDGAR on the SEC website at www.sec.gov. Alternatively, the Trust will arrange to send you the prospectus if you request it by calling toll-free 1-800-474-2737. There can be no assurance that an active trading market for shares of SLV will develop or be maintained. Buying and selling shares of ETFs will result in brokerage commissions. BlackRock Asset Management International Inc. (“BAMII”) is the sponsor of the Silver Trust. BlackRock Investments, LLC (“BRIL”), assists in the promotion of the Silver Trust. BAMII and BRIL are affiliates of BlackRock, Inc. (together with its affiliates, “BlackRock”). ©2014 BlackRock. All rights reserved. iSHARES and BLACKROCK are registered trademarks of BlackRock. All other marks are the property of their respective owners. IS-11612-0214
Bring out the option trading machine in you.

Stay on top of the option market with thinkorswim® platform tools.

You eat iron condors for breakfast. You straddle the market like it’s nobody’s business. When it comes to option trading, you think you know it all, right? Think again. There’s a world of option opportunity out there. And we keep bringing you the innovative tools to help take it on. Slice and dice data like never before with option statistics. Scan thousands of optionable stocks in seconds with dynamic scanning. It’s no wonder why Barron’s named us among the “Best for Options Traders” five years in a row.*

Learn more at tdameritrade.com/options

*TD Ameritrade was among the firms listed in the category of “Best for Options Traders” in Barron’s Online Broker Review for five years in a row (2009-2013). Barron’s is a trademark of Dow Jones, L.P. All rights reserved. Reprinted with permission.

TD Ameritrade, Inc., member FINRA/SIPC/NFA. TD Ameritrade is a trademark jointly owned by TD Ameritrade IP Company, Inc., and The Toronto-Dominion Bank. © 2013 TD Ameritrade IP Company, Inc. All rights reserved. Used with permission.
ETFs with Their Pants Down
In the world of ETFs, there’s good, bad, and ugly. Depending on who you talk to, inverse and leveraged ETFs could fall in any one of these categories. Learn what makes them tick, then decide for yourself.
WHERE DIVERSIFICATION LEAPS ACROSS BORDERS

Welcome to FX Options From NASDAQ OMX

Now individual investors can diversify their portfolios with FX Options from NASDAQ OMX. They’re easy to trade and easy to understand, and they’re settled in U.S. dollars.

LEARN MORE AT NASDAQTRADER.COM/FXOPTIONS OR CALL +1 215 496 5550
Features

10/ ETFs with Their Pants Down
Leveraged and inverse ETFs—the “trade-like-stock” products that actually win or lose more than the market they’re tracking, or profit when the market goes down—are giving some traders grief. Left unchecked, you can lose your derrière trading them. But are they for you?

18/ Shut Up and Sell
Short options aren’t as scary as some would have you think. So why the hype? Because big leverage can mean big reward—but can also mean even bigger risk. So how do you stay on the right side of a short trade? It starts with the right info.

26/ Charts? Who Needs Charts?
Picking months and strikes are big decisions for options traders. Most will choose form over function, though pretty charts got nuthin’ on the math. So it stands to reason probabilities matter. Yeah, we think so, too.

23/ Ask the Trader Guy
Our faceless guru chats about hedging without exiting, the truth about open interest, and who would win the greatest alien battle of all time.

24/ Trader Trio
Your position statement can be confusing, and well worth dissecting.
+ How to set a chart drawing alert.

Columns

16/ News + Views
The explosion of options exchanges has reaped some rewards for the “little” trader.
+ The Suit dives into your questions about what makes the Trader group tick.

38/ Futures 4 Fun
If you recently started trading futures, you may have some burning questions. Well, burn no more.

Miscellaneous

08/ A Quick Howdy

15/ Love Notes

24/ Coach’s Corner
Trading earnings can suck the life out of your option premiums. But weekly options might be the cure.

32/ Special Focus: Trade Analysis
RIDDLE ME THIS
Let’s face it. If you’ve been using thinkorswim for a spell, you probably know it’s more than just a trading platform. It’s like an answer butler at your fingertips. And we’ll show you just how far you can go to analyze your next trade.

PLUS:
ANALYZE TAB Q+A

30/ The Spotlight
While the Wall Street show goes on, Joe Tassone makes sure nothing gets in the way of your next trade.

42/ The Token

Glossary

40/ TD Ameritrade Contact Info You Could Use
Client Services Representative: 800-560-9900
New Accounts: 800-454-9272

thinkorswim Support:
800-672-2098
thinkorswim@tdameritrade.com

Tech Support:
thinkorswimtechsupport@tdameritrade.com
paperMoney Support:
thinkorswimpapermoney@tdameritrade.com
For all other inquiries:
tdameritrade.com/contact-us

General Mailing Address
200 S. 108th Ave
Omaha, NE 68154

Follow TD Ameritrade
And follow thinkorswim on Twitter, too:
@thinkorswim

BACK ISSUES OF THINKMONEY!
To view past issues of thinkMoney, hop on over to tdameritrade.com/thinkmoney. You’ll be glad you did.
The universe of exchange-traded funds is huge. Really huge. And just when it seemed investor interest in these things was catching up with their mutual-fund brethren, along came leveraged and inverse ETFs. Game over. Peace out. Retail traders rejoiced at the idea that you don’t need a degree in quantitative physics, let alone a margin account, to enjoy a way to short the market, or the type of leverage you can enjoy with options and futures. Unfortunately, common sense sort of went out the window as well, and a lot of traders have lost their pants trading inverse and leveraged ETFs because they forgot to read the print on each fund’s prospectus about how they really work. Yup, there’s a reason they can leave you scratching your head when your P/L doesn’t add up to what you thought. That’s where we cut to the chase in this issue’s cover story—“ETFs With Their Pants Down” on page 10—to uncover the naked truths about these complex instruments.

Now if you’d rather cut your teeth on shorting options rather than trade inverse ETFs, but have been too afraid to try, “Shut Up and Sell” on page 18 just might be what you need to better understand the potential risks and rewards of trading short option-strategies.

And finally, moving over to the due-diligence side of trading, when it comes to doing your own “DD,” there’s nothing like thinkorswim’s Analyze page to induce tears of joy. Sure, you probably know it can analyze the potential P/L of that butterfly spread you just put on. And you may even have a vague idea about how to use a probability cone. But did you know that it can help you understand what your position might look like after expiration on a multi-month strategy you hold? In this issue’s special focus on trade analysis, we’ll uncover some nuggets of trading gold you didn’t know existed on the Analyze tab of thinkorswim. If after reading it, your head doesn’t burst with imagination, perhaps at least you’ll be left with a better idea of just how far you can take this tool. And if not that, at least you’ll now sound like the smartest person in the room. Momma would be proud.

Happy Trading!
TD Ameritrade
Trader Group
The information presented in this publication does not consider your personal investment objectives or financial situation; therefore, this publication does not make personalized recommendations. This information should not be construed as an offer to sell or a solicitation to buy any security. The investment strategies or the securities may not be suitable for you. Any and all opinions expressed in this publication are subject to change without notice.

Options transactions involve complex tax considerations that should be carefully reviewed prior to entering any transaction.

The risk of loss in trading securities, options, futures and forex can be substantial. Clients must consider all relevant risk factors, including their own personal financial situations, before trading. Options involve risk and are not suitable for all investors. See the Options Disclosure Document: Characteristics and Risks of Standardized Options. A copy accompanies this magazine if you have not previously received one. Additional copies can be obtained at tdameritrade.com or by contacting us.


A forex dealer can be compensated via commission and/or spread on forex trades. TD Ameritrade is subsequently compensated by the forex dealer.

Futures and forex accounts are not protected by the Securities Investor Protection Corporation (SIPC).

TD Ameritrade, Inc. Member SIPC FINRA NFA

TD Ameritrade is a trademark jointly owned by TD Ameritrade IP Company, Inc. and The Toronto-Dominion Bank. ©2014 TD Ameritrade IP Company, Inc. All rights reserved. Used with permission. Product and company names mentioned herein may be trademarks and/or registered trademarks of their respective companies.

Important info

Neither Investools® nor its educational subsidiaries nor any of their respective officers, personnel, representatives, agents or independent contractors are, in such capacities, licensed financial advisors, registered investment advisors or registered broker/dealers. Neither Investools nor such educational subsidiaries provide investment or financial advice or make investment recommendations, nor are they in the business of transacting trades, nor do they direct client futures accounts nor give futures trading advice tailored to any particular client’s situation. Nothing contained in this communication constitutes a solicitation, recommendation, promotion, endorsement or offer by Investools or others described herein of any particular security, transaction, or investment. Investools Inc. and TD Ameritrade, Inc. are separate but affiliated companies that are not responsible for each other’s services or policies.

Transaction costs (commissions and other fees) are important factors and should be considered when evaluating any options trade. For simplicity, the examples in these articles do not include transaction costs. At TD Ameritrade, the standard commission for online equity orders is $9.99, online option orders are $9.99 + $0.75 per contract. Orders placed by other means will have higher transaction costs. Options exercises and assignments will incur a $19.99 commission.

TD Ameritrade was ranked #1 out of 17 online brokers evaluated in the StockBrokers.com Online Broker Review 2014. Read the full article at www.stockbrokers.com/2014-online-broker-review.html.
THE CONCEPT OF ETFs CAN BE EASILY UNDERSTOOD. WHERE IT GETS CONFUSING IS WHEN YOU CAN WIN OR LOSE MORE THAN THE MARKET THEY'RE TRACKING, OR WHEN THEY MAKE MONEY DOING THE OPPOSITE OF THAT MARKET. WELCOME TO THE WORLD OF LEVERAGED AND INVERSE ETFs. IF YOU DON'T KNOW WHAT YOU'RE DOING, THINK JEANS AROUND THE ANKLES.
Inverse and leveraged ETFs

have become some of the most actively traded products.

And why not? Priced low, they can move around a lot, and let you make interesting speculations. For example, One ETF that tracks the Russell 2000 moves 3x the amount of the index, Another, a leveraged inverse ETF that tracks the S&P 500, moves -2x that index. And because it goes up when the S&P 500 goes down, it could be a way to hold a bearish position in an account that prohibits short stock positions.

If you trade options, the premium of a short out-of-the-money put* on a leveraged ETF can be much higher than the premium of a comparably out-of-the-money put on its benchmark due to their potential higher volatility, which can lead to higher risk of assignment. These are a few reasons ETFs can be so appealing to investors and traders.

But leveraged, inverse ETFs can also trip you up if you don’t understand how they work—whether you’re trading the ETFs themselves or their options. And the goal here is to clarify those distinctions. Sure, you’ll find all this information in an ETF prospectus. And I’d encourage you to read one. But here you’ll enjoy a more direct explanation in plainer language.

LESS THAN ZERO?

First of all, leveraged, inverse ETFs are based on a given benchmark, which could be an index or another ETF. How much the price of a leveraged and inverse ETF moves is derived from the price change of its benchmark. How much the leveraged or inverse ETF moves relative to the benchmark is where it gets tricky because of the way it’s designed.

In the financial world, stocks, bonds, indices, and ETFs can’t have prices less than zero. No matter what happens, they can’t have negative prices. So, imagine an inverse ETF whose price moves in the opposite direction point for point with its benchmark price—when the benchmark moves up 1 point, the inverse ETF moves down 1 point. But, what happens if the index moves up more points than the inverse ETF is worth? For example, if the benchmark is $50 and the inverse ETF is $50, the inverse ETF would have a negative value, if the benchmark moves up $51 points to $101. A negative value could happen with leveraged ETFs if they move point for point, too. But, that doesn’t work.

So those who created inverse and leveraged ETFs solved the problem by basing the percentage change in the inverse and leveraged ETFs on the daily percentage change the benchmark. The benchmark moves up 1% in one day, and the inverse ETF moves down 1% on that day. But, what happens if the benchmark keeps going up in price, day after day? The inverse ETF keeps moving down in price, but never below $0. That’s because the lower the inverse ETF’s price, the percent change that the benchmark represents equates to a smaller point change in the ETF.

For example, a benchmark is at $100 and the 1x inverse ETF is $100. If the price of the benchmark moves up $2 to $102 in a day, that’s 2%. So, the ETF moves down 2% of $100—$2.00—to $98. If the benchmark on the following day moves up another 2%, $2.04 to $104.04, the ETF moves down 2% of $98—$1.96—to $96.04. The inverse ETF had a smaller price change on the second 2% drop than it did on the first, because the ETF’s price was lower. In that way the inverse ETF can never go below $0. Very clever. But that creates another problem.

The leveraged, inverse ETFs track the daily percentage price change of the benchmark. Those ETFs can sometimes move in ways that are counterintuitive because the prices of the leveraged and inverse are path-dependent. If the benchmark moves up $1.00 today, and down $1.00 tomorrow, that has a different impact on the ETF than down $1.00 today and up $1.00 tomorrow. Huh?

CONNECTIVE FINANCIAL TISSUE

Let’s look at two scenarios of a leveraged ETF that moves 2x the percent change of the benchmark, and an inverse ETF that moves -1x the percent change of the benchmark. Let’s assume that the benchmark and the leveraged or inverse ETFs start at $100.

In Scenario 1, the benchmark starts at $100 and moves up 1% on day 2 to $101. The leveraged ETF starts at $100, and moves up 2% to $102, and the inverse ETF moves down 1% to $99. When the benchmark drops

---

**Scenario 1**

<table>
<thead>
<tr>
<th>BENCHMARK</th>
<th>2X LEVERAGED ETF</th>
<th>-1X INVERSE ETF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day 1</td>
<td>$100</td>
<td>$100</td>
</tr>
<tr>
<td>Day 2</td>
<td>$101 (+1%)</td>
<td>$102 (+2%)</td>
</tr>
<tr>
<td>Day 3</td>
<td>$100 (-.99%)</td>
<td>$99.9802 (-1.98%)</td>
</tr>
</tbody>
</table>

**Scenario 2**

<table>
<thead>
<tr>
<th>BENCHMARK</th>
<th>2X LEVERAGED ETF</th>
<th>-1X INVERSE ETF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day 1</td>
<td>$100</td>
<td>$100</td>
</tr>
<tr>
<td>Day 2</td>
<td>$99 (-1%)</td>
<td>$101 (+1%)</td>
</tr>
<tr>
<td>Day 3</td>
<td>$100 (+1.01%)</td>
<td>$99.9798 (1.01%)</td>
</tr>
</tbody>
</table>

For illustrative purposes only.
$1.00 from $101 to $100 on day 3, that’s not quite 1%. That’s .99%.
The price of the leveraged drops 2x .99%—1.98%—to $99.9802.
The inverse rises .99% from $99 to $99.9802. Both the leveraged, inverse ETFs are a little lower than where they started—$100—while
the benchmark didn’t change at all.

In Scenario 2, the benchmark drops $1.00 on day 2, and the leveraged ETF drops 1% x 2 to $98. When the benchmark rises $1.00 back to $100 on day 3, that’s a 1.01% increase. The leveraged rises 1.01% x 2 to $99.9798. It doesn’t rise $2 back up to $100.

The inverse ETF exhibits similar behavior. That’s the nature of percentage price changes. 1% on a higher price is a bigger change than 1% on a smaller price. In both scenarios, the benchmark started at $100 and ended at $100, but the leveraged, inverse ETFs neither ended at $100, nor had the same ending value in the two scenarios. That’s why their prices are dependent on the specific price path of the benchmark.

**TRACK YOUR EXPECTATIONS**

Now, I know what you’re thinking—does .02 between the benchmark and ETFs really matter when the market is moving around? OK, that’s a pretty small difference. But this is a simple scenario involving only three price changes. Imagine the difference that could accumulate over 260 trading days in a year. While the benchmark didn’t have a net change—it started at $100 and ended at $100—in the three price changes, the leveraged and inverse ETFs both lost value, and lost different values, depending on the path of the benchmark’s price changes.

That doesn’t mean there’s something wrong with the leveraged and inverse ETFs. That’s just how they work. Because the leveraged and inverse ETFs track the daily percent changes of the benchmark, the performance of those ETFs can be quite different than the percent changes in the benchmark over longer periods. That’s what a lot of investors can find confusing. It looks like the leveraged and inverse ETFs should have done one thing, but did another.

What does that mean for traders? Should you avoid trading leveraged and inverse ETFs long term, if at all? That’s for you to decide. All trading products present risk. But some have nuances that can surprise you if you don’t understand them. In the case of leveraged and inverse ETFs, their particular nuance is that the daily, percentage price changes create discrepancies to the benchmark’s longer-term performance. So, if you’re looking for an exact leveraged or inverse replica of the benchmark, you might not get that. Go in with an educated expectation, though, and the leveraged and inverse ETFs might provide opportunity.

**Important Information**

*A short put strategy includes a high risk of purchasing the corresponding ETF at the strike price when the market price of the ETF will likely be lower. Short option strategies involve a high amount of risk and are not suitable for all investors.*

Carefully consider the investment objectives, risks, charges and expenses of an exchange traded fund before investing. A prospectus, obtained by calling 800-669-3900, contains this and other important information about an investment company. Read carefully before investing.

Leveraged and inverse ETFs entail unique risks, including but not limited to: use of leverage; aggressive and complex investment techniques; and use of derivatives. Leveraged ETFs seek to deliver multiples of the performance of a benchmark. Inverse ETFs seek to deliver the opposite of the performance of a benchmark. Both seek results over periods as short as a single day. Results of both strategies can be affected substantially by compounding. Returns over longer periods will likely differ in amount and even direction from the target return for the same period. These products require active monitoring and management, as frequently as daily. They are not suitable for all investors.
Get ahead of the futures learning curve.

When trading futures, it starts with what you know. Our free educational resources can help empower you with a strong knowledge base—so you can become a more informed, confident futures trader.

- 24/7 support: Get answers from our futures specialists—many who were experienced floor traders themselves
- CNBC “Futures Now”: Get strategic insights from respected third-party traders on this live, streaming show
- thinkorswim® Learning Center: Learn the ins and outs of the thinkorswim® trading platform through tutorials, demos, videos, and more
- Live squawks from the pits: Hear what the futures pros are saying, right as market events happen

Learn more at tdameritrade.com/futures

Futures accounts are not protected by the Securities Investor Protection Corporation (SIPC). Futures trading privileges subject to TD Ameritrade review and approval. Not all account owners will qualify. Trading futures involves speculation, and the risk of loss can be substantial. Clients must consider all relevant risk factors, including their own personal financial situation, before trading.

Third-party research and tools are obtained from companies not affiliated with TD Ameritrade, and are provided for informational purposes only. While the information is deemed reliable, TD Ameritrade does not guarantee its accuracy, completeness, or suitability for any purpose, and makes no warranties with respect to the results to be obtained from its use. Please consult other sources of information and consider your individual financial position and goals before making an independent investment decision. Past performance does not guarantee future results.

Access to real-time market data is conditioned on the acceptance of the exchange agreements. Professional access differs and subscription fees may apply. Diversification does not eliminate the risk of experiencing investment losses.

TD Ameritrade, Inc., member FINRA/SIPC/NFA. TD Ameritrade is a trademark jointly owned by TD Ameritrade IP Company, Inc., and The Toronto-Dominion Bank. ©2013 TD Ameritrade IP Company, Inc. All rights reserved. Used with permission.
DA TWEETS
- 2 days waiting for this market...and for what?? .25 uptick? Pfff...I’m getting beers...
  @JaviFusco

- @thinkorswim Did u guys use Obamcare programmers 4 your disastrous software upgrade?...#FAIL
  @HedgeBanger

- The user interface lead for @thinkorswim needs to ease off the meth.
  @AdamBTC

- @ryanowalton Input: Love needed. Calculating feelings and emotions...Output:
  <3 <3 <3
  @thinkorswim

- I hear @TDANSherrod is getting her head shaved in the @TDAmeritrade office for a properly working thinkorswim.
  @MNYCx

- @MNYCx I’m working to resolve issues. I have no time to shave my head. Once resolved, if this will make everyone happy, I will.
  @TDANSherrod

- @MNYCx In all seriousness we are working around the clock on TOS issues. But now that bald @TDANSherrod is on the line we’ll dig deeper.
  @thinkorswim

DA QUIPS
- On cool scripts
  Just write a script to switch the colors on active trader buy/sell buttons. Really turned my trading around.
  Denida

- On charting
  I changed to a scented candle chart so I can just smell the moves coming.
  Jack

- On canine indicators
  In the morning, my dog barks how many points AAPL* will move. His portfolio is outperforming mine.
  Scotty

- On domestic skills
  If I ever joked to my mother that her sweeping skills would someday be a skill in the Olympics, she would have hit me with the broom.
  Dustin

- On athletic wear
  LULU* has a bra called the “Ta Ta Tamer”...Now there will be a jock called the “Nad Nanny.”
  Brad

- From a famous dude
  Two things are infinite: the universe and human stupidity; and I’m not sure about the universe.
  Einstein

Important Information
These comments are excerpts from chat rooms, emails, and tweets submitted by TD Ameritrade clients, as their views and many not reflect those of TD Ameritrade. Testimonials may not be representative of the experience of other clients and are no guarantee of future performance or success.

*Security symbols displayed for informational purposes only. This is not a recommendation to trade any specific security.
Ask The Suit

A little Q&A with Nicole Sherrod, Managing Director, Trader Group at TD Ameritrade

Q: What else can we expect later in the year in terms of mobile enhancements?
A: Considering the world we now live in, our core development focus for mobile is divided equally between Android and iOS for both phone and tablet. My Mobile Development team is working to bring parity between the most utilized and beloved features and datasets in thinkorswim and Mobile Trader. By the time you are reading this issue, we will have just rolled out a host of new features for Android like the ability to roll forward on option positions and to trade directly from the charts.

It’s not lost on us that the evolution from 3G to 4G to 5G is only going to continue. (If only the carriers would keep up with us...) Traders need a fast connection and the advancements in the mobile space are supporting the migration of traders towards an untethered future. My team is very focused on gearing up for that inevitable event.

Q: Can you suggest any new thinkorswim features that I should be sure to check out?
A: When I was single, people would tell me all the time that I was too picky. I was always looking for the perfect guy. Now I’m older. But I’m still very picky. But now it’s all about finding the perfect trade. And there’s three ways to do that which I consider “must haves.”

1/ Option Hacker — For me, this tool was love at first sight. And our recent enhancements to Option Hacker allow you to screen for virtually any criteria that you could possibly dream up. Are you a premium seeker? Find options with a desirable premium all within a certain number of days of expiration. However you like to trade…the option hacker can help you filter the universe of for just the right option.

2/ Stock Hacker — The latest enhancements to this tool will be available in the spring. You know all the new fundamental data we recently rolled out on the Analyze tab? Well, you will soon be able to filter on virtually every fundamental data component on that tab. You’ll even be able to combine both fundamental and technical elements into the perfect scan.

3/ thinkorswim Sharing — The beautiful thing about our new thinkorswim Sharing feature is that, with two clicks I can share my perfect screen with my loved ones so that they too can profit from the brilliance of my option or stock hack. It’s only nine more months till Christmas. Now you know what I’ll be giving everyone on my list.
Toys for Traders
A few of our latest trading faves

SHARE THE LOVE
Yup, we’re saying it again. Share your charts and custom settings, including scans, with anyone just by pressing the “share” button in the upper corner where it’s available. If they have thinkorswim, they can drop it right in their software and see your brilliance for themselves.

OPTION SCREENER
If you missed the blurb in “Trader Trio” in thinkMoney’s last issue (#22, Winter 2014), you can now scan for single options that meet certain criteria, such as delta, days to expiration, or even strike price. Add a stock filter on top of it, such as price and volume, and you’ve got a one-two punch for finding your next option trade.

thinkOnDemand
Do you wonder what that “OnDemand” button is in the upper right corner? thinkOnDemand allows you to go back in time and trade fake positions as if the market was ticking in real time. Test your trading reflexes tick-by-tick, or jump to a future date to see how it all turned out. It’s fake money, so you only risk losing your ego.

Alphabet Soup Are more options exchanges better for me?

Words by Thomas Preston
Illustration by Joe Morse

One of the big changes over the past decade is the creation of new equity option exchanges—12 in all now. Back in the day, there were just four—CBOE, Amex, Pacific, and Philly. But NYSE bought Amex and Pacific to form NYSE Amex and NYSE Arca respectively. Nasdaq bought Philly and became Nasdaq OMX PHLX. CBOE opened CBOE C2. Throw in BATS, BOX, ISE, and MIAX, and it starts to look like exchange soup. But has all this competition benefitted the little trader? Let’s see.

The trading volume of listed equity options has been growing over time, thanks in part to broader use of option strategies by retail traders and investors, which is why creating a new exchange has been attractive. Powerful software, high availability of services, and low latency data delivery are behind the technology building the new all-electronic exchanges. Screen-based market making is taking the place of the colored jackets and frantic hand waving.

Technology aside, as Alan Grigoletto of the Options Industry Council puts it, “Fungibility can’t be dismissed. Now that options can be traded on multiple exchanges, their costs naturally come down.” As well, the new exchanges increase competition, not just for tighter bid/ask spreads, but for innovative trading products like mini options and options on new ETFs and indices.

Translation: the cost of trading has come down for you and me because of tighter bid/ask spreads, there are more products to choose from, and liquidity—the ability to get in and out of trades fairly easily—has increased. The bottom line? When you route an order, you may just choose “Best,” which is the default in thinkorswim. This uses TD Ameritrade’s order routing algorithms to search for the exchange with the best execution price. At the end of it all, you don’t really have to worry so much about which exchange fills your order, as long as you get filled at a good price and quickly.
Short options aren’t as scary as some would have you think. So why the hype? Because big leverage can mean big reward—but can also mean even bigger risk. So how do you stay on the right side of a short trade? It starts with the right info.

Words by Kyle Murphy
Photograph by Fredrik Brodén
The term ‘short’

has been given a bad rap over the years. And for good reason. Without even knowing what the term means, the average investor listening to pundits and naysayers would have you believe shorting will put you in the poorhouse, or that’s a part of what sunk the economy just a few years ago. The reality is while shorting is inherently risky, when used wisely, it can be useful. But in the hands of a reckless trader, that’s where the problems begin.

The term “selling short” simply means you’ve changed the typical order of operations. While most people buy a stock then sell it in a short sale, one sells a stock then buys it. While there are mechanisms that need to be in place in order for short selling to occur (such as approval to short a stock with the stock being available to short), the ability to short sell any financial instrument is a necessary component of a fair market, as it completes the opportunity to match buyers and sellers at a transaction price both parties deem fair.

THE BIG RISK

Of course, when you sell an option short, you incur the obligation to either buy or sell the underlying security at any time up until the option expires. Unfortunately, that obligation means you may have to either buy a stock higher, or sell it lower, than where it’s currently trading. In a nutshell, if you’re forced to fulfill the obligation that may arise from a short-option position, you’ll be forced to do something you wouldn’t otherwise do.

In the case of a short-call position, you incur the obligation to sell the stock at a set price, and there’s no limit to how much higher the stock can rise before you may have to buy it back.

With a short-put position, you incur the obligation to buy the stock at a set price. And while the stock can drop considerably before you decide to sell, your risk is technically limited because stocks cannot drop below zero.

Why would you do that? There are two main reasons experienced options traders might employ the short-put strategy—to buy the stock at a lower price than where it’s currently trading, or to speculate on a stock’s direction and collect periodic income from the time value of the short put.

BUYING STOCK AT A LOWER PRICE

With a short-put position, you take in some premium in exchange for taking on the responsibility of possibly buying the underlying security at the strike price. This money is yours to keep no matter whether the stock trades below the strike of the short-put option. At any time prior to expiration, if the stock trades at a price that is lower than the strike price, then the person who is long the put has the right to (and will likely) exercise the option. In that case, you’ll be assigned on your short-put position, meaning you have to buy the underlying stock at the strike price. Consider the following:

Let’s say you’re mulling over the idea of buying 100 shares of XYZ stock currently trading at $64.50. However, you don’t want to pay more than $60 a share to own it.

You could sell the XYZ January 60 put for $2.00 per contract, obligating you to pay $60 per share for XYZ stock if assigned—exactly what you wanted. But since you’re collecting $2.00 for the put, your net cost for the trade is $58 per share (plus commissions and fees).

THE SCUTTLE ON DIVIDENDS

It’s true that if XYZ stock happened to pay a dividend, then by owning XYZ you’d be entitled to that dividend. By being short a put in XYZ stock on the other hand, you would not be entitled to a dividend. That said, keep two things in mind.

First, if you happen to get assigned on your short XYZ puts, then you’d be forced into taking delivery of
the stock, thereby granting you the right to all future dividend payments so long as you remained the stock owner.

Second, all American-style put options are adjusted to some degree for upcoming dividends. Puts sold on dividend-paying stocks are built to trade at a slightly higher premium than where they otherwise would trade if the underlying stock did not offer a dividend, all things being equal. Among other factors, the deeper in the money the put option happens to be, and hence, the greater the likelihood that your short option is assigned and converted to stock, the greater the adjustment for the dividend. So the options world has addressed that pesky concern.

**WHAT ABOUT ASSIGNMENT?**
If you get assigned, you take delivery of the stock at the strike price of the short put. So what now? Well, since you took in some premium via your put sale prior to buying the stock, how about taking even more premium by selling a call option after you buy the stock?

Suppose that the stock settled at $59.75 per share at expiration and you get assigned, thereby forcing you to buy shares of XYZ stock. On the following market opening after expiration, you note that XYZ is trading at around that same level, just below $60 per share. At this point, you could sell the XYZ February 60 call at, say, $4.00. This premium is yours to keep regardless of where XYZ settles at expiration.

If XYZ stays below $60 per share until expiration and you don’t get assigned, the February 60 calls go out worthless, you’re $4.00 better off than if you had done nothing. On the other hand, if XYZ trades above $60 per share prior to, or at, expiration, then you’d likely be forced to sell your stock at $60, which is the same price at which you were forced to buy it in the previous expiration. You would be no worse off, and in fact, you’d probably be better off since in addition to the premium that you collected when you sold the put, you’d also have the premium collected when you sold the call, less the applicable transaction costs like commissions, contract fees, and assignment fees.*

**SELLING SHORT PUTS CAN BE A GREAT WAY TO BUY A STOCK** you were committed to buying anyway, while allowing you to collect some additional premium through the option sale. At first glance, the strategy may seem extremely risky. And it is. However, upon closer inspection, you can see there’s potentially more risk in buying the stock outright due to the collection of the option premium. Finally, whether or not you’re assigned on your short-put option, the premium you collected during the option sale is yours to keep.

For illustrative purposes only.

---

**Finding Shorts**

If you need a helping hand finding a short option candidate, try using Option Hacker on the thinkorswim platform. Just follow the steps below from the image above.

1. Under the Scan tab, select Option Hacker in the submenu.
2. Select the watchlist in the drop down box next to “Scan in.”
3. Choose your option criteria.
4. If it would help, you can also add a stock filter, such as “% change” to find movers and shakers.
5. Hit the scan button and watch your results populate at the bottom of the screen.

---

**Important Information**

For more information on the risk of options, see page 43, #1 & 3. The naked short put strategy includes a high risk of purchasing the corresponding stock at the strike price when the market price of the stock will likely be lower. The risk of loss on an uncovered call option position is potentially unlimited since there is no limit to the price increase of the underlying security. Naked short option strategies involve the highest amount of risk and are only appropriate for traders with the highest risk tolerance. A covered call strategy can limit the upside potential of the underlying stock position, as the stock would likely be called away in the event of substantial stock price increase. Short options can be assigned at any time up to expiration regardless of the in-the-money amount. Option strategies designed to generate income month after month can entail substantial transaction costs, including multiple commissions, which may impact any potential return.

For simplicity, the above examples did not include transaction costs in the calculations. For more on transaction costs, see page 9.
Futures trading is not suitable for all investors, and involves risk of loss. CBOE®, CBOE Volatility Index® and VIX® are registered trademarks and Execute SuccessSM, CBOE Short-Term Volatility IndexSM and VXSTSM are service marks of Chicago Board Options Exchange, Incorporated (CBOE). S&P®, and S&P 500® are registered trademarks of Standard & Poor’s Financial Services, LLC and are licensed for use by CBOE and CBOE Futures Exchange, LLC (CFE). S&P does not sponsor, endorse, sell or promote any investment product that is or may be based on the VXST Index. © 2014 CBOE. All Rights Reserved.

Introducing CBOE Short-Term Volatility IndexSM (VXSTSM) futures, the newest volatility innovation from CBOE.

By tracking 9-day expected volatility, Short-Term VIX is particularly reactive to changes on the S&P 500® Index. So now you have the opportunity to capitalize on market events. Better manage near-term risk. Capture risk premium with weekly expirations. And help take advantage of volatility for the here and now.

Download the Short-Term VIX quick reference guide at ShortTermVIX.com
Tweet with dollar-sign tag $VXST
Q: Hey, Trader Guy! I know that stock trades settle T+3, three days after the trade date. Does that mean I don’t actually own the stock on the day I buy it?

A: No. You own the stock when you do the trade, and have all the accompanying risk and potential. But you have three days max to pay for the stock when you buy it, or deliver the shares if you sell it. The settlement process is kind of involved, but the reason the SEC (Securities and Exchange Commission) has T+3—it was T+5 for a long time—is that unsettled trades are risky for the whole market. The longer the settlement time, the more risk of a big move in the market, and this could mean investors might not be able to pay for the transactions. Generally, in today’s online trading world, you need the funds in your account to cover the requirements of an opening transaction before you can route the order.

Q: Hey, Trader Guy! If I want to reduce the deltas of an options strategy but don’t want to close any of my positions, is it better to use stock, or an option spread, as a delta hedge?

A: In trading, it’s not necessarily a question of “better,” but rather whether or not you understand the risk and benefits of the different choices. Because 100 shares of stock has a delta of 100, you could potentially reduce your delta very quickly by buying or shorting stock. The downside, though, is that stock positions can be capital intensive, and if the market rallies or drops, there’s a risk the stock hedge can lose more than the option portfolio makes.

Alternatively, option spreads often have deltas that are relatively small, which means you might need to execute a lot of them to reduce the option strategy’s delta. And that can mean higher transaction costs. Think of it this way: match the hedge’s type of risk with the position’s type of risk. Do you have a lot of naked short options with a lot of risk? Then a stock hedge might make sense because it could come close to offsetting the options’ potentially large losses. Do you have an option spread? Then a stock hedge might be too risky, and another option spread with offsetting deltas might make more sense.

Q: Hey, Trader Guy! I like to trade options that have a lot of open interest. But when new option expirations are opened, sometimes the open interest is low. Should I avoid them until their open interest is higher?

A: Higher open interest can be an indication of liquidity and trading activity. But new option series, like the ones that get added after each expiration for example, sometimes don’t have any open interest until several days after they start trading. That’s because people haven’t started opening positions and are maybe trading the other expirations. That doesn’t mean, though, you should avoid trading them. If the options in the other expirations have a high open interest, it’s likely the new series will be liquid as well, and market makers are still obligated to honor their bid/ask prices even if the open interest is zero.

Q: Hey, Trader Guy! OK, let’s say you’re going to fight the Fed, and you could have either the Terminator or the Predator to back you up. Which one do you choose?

A: Well, the Predator is a sentimental favorite. I mean, it’s got the shoulder rockets and the whole dreadlock thing going on. But the bottom line, it’s a sentient being. I think the Fed would completely demoralize it by pushing interest rates in a direction the Predator would resist, and the Predator would just go to the invisible spaceship and fly away. The Terminator is a machine, and you could just program it to take its losses to outlast the Fed.
POSITION STATEMENT

HOW IT WORKS AND WHY IT MATTERS

Keeping track of profit and loss (P/L’s) is standard. And if you’re not in the know, the Position Statement lives under the Monitor tab.

First, with derivatives, these values will always be calculated in real-dollar terms to allow for apples-to-apples comparisons. In other words, if you see a P/L on an option position of $1.00, that is after any multiplying effect of quantity and specification and not a dollar gain on the contract price. So a $0.25 move in say, an S&P 500 options contract would be represented as +/- $25.00, after the multiplier is considered. Now, let’s break down each column on the page.

P/L Open. Measures the gain or loss of position value since an opening trade was made. When looking at a combined position (for example, all options in X symbol), P/L Open will not include any positions that have already been closed. In math-speak, P/L Open = (AVG COST x QTY) – (MARK x QTY).

P/L %. Same thing as P/L Open, but expressed as a percentage. P/L Open = ((AVG COST x QTY) – (MARK x QTY)) / (AVG COST x QTY).

P/L Day. Measures a position’s current value against the previous day’s close. Note that when looking at a combined position (for example, all options in X symbol), the P/L YTD will include gains and losses from any position that’s been closed since the year began. P/L Open = (AVG COST x QTY) – (CLOSE x QTY).

Mark Value. This is the value of the position at its current mark price (the amount of money it would give/take to close the position). With a short position, this would be a debit, since the cash from selling the position has already been included. In the case of a long position it’s a credit, since it would bring in funds when liquidated.

BP Effect. This is the impact on your margin, or buying power, available in your account.

Last, the greeks columns (delta, gamma, theta, vega) simply include each total position greek. For example, if you own 10 call options, and the greek column states 495 deltas, each call has 49.5 deltas.

FIGURE 1: Position Zen. All of the vitals for the trades you have on right now live on the Position Statement of thinkorswim. And if you can’t tell up from down because you’re holding too many positions, organizing your multiple positions into “subgroups” can help organize your worried mind. For illustrative purposes only.
POSITION SUBGROUPS
GET ORGANIZED FOR PEACE OF MIND
Captain Obvious says, “trading can be complicated.” Organizing combinations of positions with differing strategies, possibly in separate accounts, can be a challenge. To simplify, thinkorswim takes the Position Statement a step farther with a flexible system of “subgroups” you can use to arrange custom trades based on defined criteria. So at a glance you can see how any set of positions are performing. (Refer again to Figure 1.)

With subgroups, you can assign either a whole position or individual trades in a position, to a defined subgroup. For example, you can separate some or all of the spread trades of a given type from other option positions. Or you could separate your “speculative” trades from your “high probability” trades to contrast your strategies’ effectiveness. According to your preference, you decide how to divide these positions. Within a subgroup, the software will track the metrics of a given position (e.g. P/L, delta, net-liquidation value, etc.), even if that trade is only a portion of the overall position in a given security. Positions can also be entered or exited directly within a subgroup so you can track their progress over time.

As for how this all works? To start, click on the action menu at the top of your Position Statement and check “Show Subgroups.” Then, right-click the position you’d like to move and in the menu choose “Move to Group > Add Group…” Since this is the first one you’ve created, you’ll have to give it a name. But other than that, there’s nothing to it. Other orders or positions can be added to that group from the same menu. To add an individual position trade, go to the Trade History section of the Account Statement and right-click on the one you’d like moved.

To assign subgroups to new positions, you have a couple of options. If you select a subgroup in the account selector at the top of the platform, any orders sent will go to this subgroup automatically. As well, a subgroup can be selected directly on the Order Confirmation dialog box. Closing orders can be assigned to the same subgroup as the opening transaction by checking “Assign subgroups to closing orders” in the Orders section of the Application Settings.

DRAWING ALERTS
WATCH OUT FOR THAT TREE, UM, I MEAN TREND
And for something new, we’ve added a different kind of alert on thinkorswim Charts—the ability to add alerts based on a chart drawing (e.g. trendline, retracement, channels, etc.). Now you can be notified whenever a security’s price has broken through a trend that you’ve defined, without being clairvoyant and picking a price. Cool.

The mechanics of setting up such an alert are straightforward. Simply right-click on a created drawing and select “Create alert with drawing….” This opens up the alert-creation menu where you can define how you’d like the alert to trigger. Since all drawings are in effect simple lines, an alert can trigger when the price crosses above or crosses below the defined line, or whichever comes first.

Beyond that, all the standard alert preferences can be set from this menu, such as submission time, notification method, or whether to track a reverse crossover. When these parameters are set to your satisfaction, click “Create” to set the alert. Creating a drawing alert will place a flag on the drawing to indicate that an alert has been set which can be double-clicked to either edit or cancel the alert.

Drawing alerts on all symbols may also be viewed in the “Alert Book” section of the “Marketwatch” tab, alongside any other alert types you may have set. This section shows you the name of the drawing and symbol for which the alert has been set, as well as the timeframe of the chart for which the alert applies. This last bit is very important to keep in mind to avoid confusion: since lines of various types change slope when applied to different chart aggregations, remember that an alert will trigger only when a crossover occurs on the same aggregation on which the alert was set.

For example, it’s possible to see a crossover on a 15-minute chart that does not appear on a 5-minute chart. So if the alert was created on a 5-minute chart then the alert would not trigger. To remind you of this, the chart will only show a flag on charts of the same aggregation, and the entry in the order book will specify to which aggregation the alert is applied.

For more information on the risks of investing and options, see page 43, #1&3.
CHARTS?
WHO NEEDS CHARTS?

Picking months and strikes are big decisions for options traders. Most will choose form over function, though pretty charts got nuthin’ on the math. So it stands to reason probabilities matter, right? We think so.

Words by Thomas Preston Photograph by Fredrik Brodén
We’re visual creatures.

We like pictures and colors. So, it’s understandable that charts are pretty attractive to investors and traders. What’s not to like? Bars and candlesticks. Trendlines and fibonacci. Momentum and moving averages. You can load up a chart with so much information hopefully it will give you a general idea about the direction of a given stock or index.

The reality is, to create a smarter strategy overall, it’s not just about the pictures. It’s about the math. While charts can be helpful, I’ve yet to have a chart master show me with absolute certainty the probability a stock or index will reach some dreamy target price. Nope, that’s math, my friend. And once you have the math right, you can pick an optimal strategy on both trend as well as probabilities.

Like powerful charts, probabilities are conveniently calculated on the thinkorswim® platform.

TRADING AND TEA LEAVES

The goal here isn’t to talk you out of your charts. In fact, it’s to help you turn a chart’s directional bias—bullish or bearish—into a strategy based on the probability of making a profit. Quantifying the probability of a profitable strategy, or even of a stock reaching a certain price, helps you longer term make smarter decisions. And you do that by looking at the probability of a stock’s option expiring in the money or touching its strike price. However, “touching” probability, is not a certainty, the market can be inconsistent, and can move quickly and drastically.

The probability calculation uses the option’s strike price, the current stock price, time to expiration, as well as the option’s implied volatility. Crucially, the implied vol is derived from the option’s market price, so a single probability number contains the market’s “implied” estimate of how much the stock price might move.

In fact, no chart can tell you that. But why should you rely on probability numbers? Because they contain current market information via the option prices themselves, making probability numbers more responsive to changes in volatility and time. Remember, the more volatile the stock, or the more time to expiration, the more likely a large price change. Market makers make out-of-the-money option prices more expensive to reflect this. All else equal, higher option prices mean higher implied vol, which feed directly into the probability formula.

In this way, it’s not just your opinion of a stock’s chart that should go into a strategy. It’s the market’s collective wisdom.

A PICTURE’S WORTH A THOUSAND TRADES

Visualize this with the “Probability of Expiring Cone” on the Analyze tab, under the Probability Analysis subtab (see Figure 1). This feature points to future dates, revealing the range encompassing one standard deviation of potential stock prices. That’s geek-speak for a 68% likelihood of price action staying within that range before expiration.

You can edit the “Probability of Expiring Cone” study to show a different probability range, say 68%, 95%, and 99%. The prices where the cone intersects with future expiration dates are the upper and lower boundaries of the stock price’s theoretical range for that probability number. The further out you look, the wider the stock’s potential price range.

NARROW YOUR CHOICES

Despite formal textbook definitions, traders tend to see strike prices differently. Strike prices above and below a current stock price are like boundaries—levels the stock price may or may not reach in the future. Looking at the probability numbers on the Trade page at different strike prices and for different expirations, you can see what the market thinks of a probability that a stock price will either stay inside, or move beyond, a particular strike price. And knowing the probability can help you develop a more confident strategy relative to your directional bias. At the end of the day, it’s easier to make sense of options with a few handy guidelines, to wit:

1. Pick the expiration
2. Pick the strike price
3. Pick the strategy

Step One: Pick the expiration. On the Trade page, scan the days to expiration on the left-hand side for each month. For opening trades, a trader may consider using options that have between 30 and 60 days to expiration, or whichever expiration is closer to 45
days, give or take a few days. The logic? For credit strategies that partly rely on positive time decay, the number of days to expiration has a balance of a growing rate of time decay, and a higher absolute level of option extrinsic value. Sure, you can place a credit strategy in an expiration with six months out that might have a large credit. But the rate of time decay is lower. And you can place a credit strategy in an expiration with only a couple of days left that has a high rate of time decay, but no premium. 45 days may be a good place to start.

For debit strategies that rely on a favorable movement in the stock look for a balance duration of 30-to-60 days to expiration. This might give the stock time to move enough so the strategy might become profitable.

More time than 60 days gives you more duration, but your trade might not change in price much when the stock price changes. Less time to expiration can give you a more responsive debit strategy, but there isn’t as much time for the stock price to make a favorable move.

**Step Two: Pick the strike price** After narrowing down expirations, narrow down the strike prices. You may consider looking for out-of-the-money (OTM) calls and puts that have about a 68% probability of expiring worthless. That number is available on the Trade page as the “Probability OTM” field in the Customize choice in the Layout menu (Figure 2). “About” 68% might be 64% on the low side and 72% on the high side, for example. A 68% probability OTM means theoretically the option will expire worthless 68% of the time. This means, if you had shorted that option, theoretically 68% of the time you would keep the option’s premium, less transaction costs, as profit by expiration. Of course, 32% of the time the short option could lose money, so it’s not a trading strategy in and of itself and nothing is guaranteed.

For further information on this topic, see page 43, #1-3.

**Step Three: Choose a strategy.** Finally, create a trading strategy the combines your directional bias from both charts and probability numbers on the trade page. You can do this by comparing other options to the option at the strike that has about a 68% probability of expiring worthless and between 30-and-60 days to expiration.

If you have a bullish bias, maybe you’d look at a short OTM put vertical, a bullish option strategy that loses money when the stock drops a lot, but can make money if the stock goes up, stays the same, or even drops by a small amount.

Let’s say you see a short one-point put vertical whose short option is at that reference strike trading for a $0.40 credit. Look at the put vertical at the same strike in a further expiration. Is the credit much higher or lower? What’s the probability of the short option strike expiring worthless in that further expiration? What’s your potential credit if you move the short strike to the strike with a 68% probability of expiring worthless, or a higher probability of expiring worthless in that month? This lets you compare the credit you may get—higher or lower—for a bullish short-put vertical strategy when you move away from that reference strike. You might choose a lower credit for a higher probability of expiring, worthless, or a higher credit for a lower probability of expiring worthless. The point is, you’re quantifying the potential profit, max loss, and probability of a trade that originated from a chart so you can make a more informed choice.
Sure. Lots of famous Joe’s out there—Joe Namath. Joe Pesci. And naturally, Joe Camel. But we think our Joe Tassone’s the coolest of all. In TD Ameritrade’s Active Trader group, he’s the reason your trades hit their electronic lay-ups just the way they should.

Growing up on Chicago’s south side, Joe would watch family members trade on the floor of Chicago exchanges, which led him to trade equity options at a prop firm early in his career. Now, he’s in his TD Ameritrade groove on the trading platform, with his eye on the ball and sporting a skill for clutch shots.

So, Joe, what’s a typical day for you?
I handle day-to-day operations and production issues, making sure the system runs smoothly. I also handle most of the technical communications between the thinkorswim platform and TD Ameritrade.

Uhh…Can you translate that into English?
I monitor the health of thinkorswim servers. I make sure we route all orders correctly, and market data and quotes are updating in real time. I handle issues throughout the day—things like incorrect margin, or problems with routing lines. Maybe a customer’s order was rejected in error. There’s always something. Some customers call us the firemen because we put out the blazes and deal with the crises, small and large. When an issue happens during the trading day, there’s no time margin. Deadlines are like “right now.”

Have you had any close calls?
About a year and a half ago, a technology certificate expired. No one could log into thinkorswim one Saturday afternoon. Our developers had to regenerate the certificate. We ended up resolving the problem 15 minutes before the open on Sunday.

You must have been sweating.
Oh yeah, but I had a tremendous sense of relief when we got it fixed. The end result was no client impact and that’s what we’re looking for. I do take it personally if something goes wrong with the system. I feel responsible. If something misfires, it’s on me to fix it at once and keep it from happening again.

How do you sleep at night?
I’m on call 24/7. In the middle of the night, if a futures routing line goes down, I work with our developers, the exchanges, and technology staff to address it. But, we have a team atmosphere. I can’t and don’t do everything myself. I have to be able to trust the people around me as well and rely on them when I need to.

With so much pressure, how do you blow off steam?
I play sports. But, I’m not a guy who likes to just go to the gym. I play basketball, softball, football. I don’t like to run unless I’ve got a ball in my hand.

What’s ahead for your group at TD Ameritrade?
Keep the systems running, keep innovating, stay ahead of what the market has to offer.

Good thing you got big feet. Lots of responsibility. So, what size shoe do you wear?
Size 15—yeah, it’s a pain. It makes shopping for shoes kinda hard.
Keep the market where you want it—in sight.

Trade Architect® helps put your strategy into focus.

Keep up with the turns and trends in the market with Trade Architect®, an intuitive, Web-based trading platform you can access anytime, from any computer. It puts the tools and features you need front and center—making it easier for you to identify strategies, monitor market action, and be ready to strike whenever potential opportunities arise.

Explore Trade Architect at tdameritrade.com/tradearchitect
LET'S FACE IT. IF YOU'VE BEEN USING THINKORSWIM FOR A SPELL, YOU PROBABLY KNOW WHAT A KICK-ASS TOOL IT IS. AND AT SOME POINT, YOU MAY TEST ITS LIMITS. HERE'S A FEW IDEAS TO CONSIDER TO GET YOUR JUICES FLOWING ON JUST HOW FAR YOU CAN GO TO GET YOUR BURNING QUESTIONS ANSWERED ABOUT WHAT MIGHT HAPPEN TO YOUR POSITIONS IF

WORDS BY THOMAS PRESTON PHOTOGRAPH BY FREDRIK BRODÉN
Yet, once you understand how the various tools work, you’ll see how a small investment of time can make you a much smarter trader and help you navigate even the most daunting of market jungles.

Now, most Hollywood jungle adventures involve pith helmets, khakis, and a sketchy, inscrutable “guide.” Feel free to dress any way you want. But as I’m the guy who actually built the Analyze tab, you can trust I’ll steer you away from the crocodiles and toward the gems and jewels. In my opinion, think of the Analyze tab as a way to answer trade riddles—whether they’re easy or complex. To start with, you might ask three not-so-common questions which the Analyze tab can help you answer. But first, let’s get a lay of the land and hack through some of the underbrush.

SPEARS UP
The Analyze tab has four pages, or subtabs:

1. Add Simulated Trades
2. Risk Profile
3. Probability Analysis
4. thinkBack

Starting last, thinkBack lets you see end-of-day option prices going back 10 years, and lets you simulate trades based on that data. But we’ll save thinkBack for another discussion. The Add Simulated Trades, Risk Profile, and Probability Analysis tabs are divided into three sections. On the top you’ll find the main visual display of the specific functionality of the tab, like the option quotes and order entry of the Add Simulated Trades, or the profit/loss graph on the Risk Profile. Below that, in the middle of the page, is the Price Slices section, common to all three subtabs. At the bottom, you’ll see the Positions and Simulated Trades section, also on all three subtabs. I’ll be referring to those sections by name so you can find the controls you need.

Also, to prime the pump you may need to enter a few simulated trades so you can see data on the Analyze tab. To do that, click on the Add Simulated Trades page at the top and enter a symbol in the symbol field (see Figure 1).

On the Add Simulated Trades page, you create simulated trades the same way you create real trades on the Trade tab. Left click on the bid or ask to create a simulated buy or sell, or right click to create a simulated spread. Now, let’s see how the Analyze page can tackle some questions. Even though these may not be your exact trading questions, you’ll glean enough Analyze tab functionality to answer your own.

1—HOW TO GAUGE THE IMPACT OF FUTURE VOLATILITY

**Question:** I trade earnings where the front month vol is much higher than the back month vol. How do I gauge the impact on my position of a larger drop in the front month vol, and a smaller drop in the back month vol after the earnings are announced?

**Answer:** You might be familiar with the Theoretical Price tool on the Trade tab that lets you change the stock price, date and volatility. But when you raise or lower the “Vol Adjust,” it pushes the vol of all the options in all expirations up and down equally. That’s not so handy when it comes to earnings.

You want to adjust volatility differently on one expiration from another because changes in the intermonth volatility skew—where the implied vol in one expiration is very different from the implied vol in another—can significantly impact your positions across multiple expirations. The Analyze page lets you test changes in that intermonth skew (see Figure 2).
THINK OF THE ANALYZE TAB AS A WAY TO ANSWER TRADE RIDDLES. YOU MIGHT ASK NOT-SO-COMMON QUESTIONS WHICH THE ANALYZE TAB CAN HELP YOU ANSWER.
1—Look in the Positions and Simulated Trades section for a small wrench icon on the far-right-hand side.

2—Click on the wrench icon and look for “More” in the middle of the section.

3—Click on “More” to open up the controls for the individual expirations.

Vol Adjust fields open for each expiration in which you have an actual or simulated position. You can adjust the vol lower in one month and higher in another month, or vice versa. The Vol Adjust raises or lowers all the implied vols of the options in that expiration by the number of points in the adjustment. For example, a +5 vol adjustment would move the implied vol of an option from 11% to 16%. When you do this, the adjusted vols are used to calculate the theoretical values and greeks, as well as the theoretical profit/loss of the position (step 4 in Figure 2 page 35).

2—HOW TO ANALYZE TOMORROW’S GREEKS TODAY

Question: I can see the greeks of my positions on the Monitor page, and they show me the greeks at the current stock price and days to expiration. But I’d like to know what the greeks might be with only a day before expiration. How do I do that?

Answer: Lucky for you, the Analyze page’s native language is greek! (Just don’t get it started on how “vega” isn’t a Greek letter.) And there are a couple ways to do this—with numbers or pictures.

The Numbers—Price Slices

1—Referring to Figure 1, type the underlying’s symbol of one of your positions in the symbol field in the upper-left-hand corner of the Add Simulations page. This will load the position in the Analyze page.

2—Referring to Figure 3, under the Price Slices section, you’ll see the greeks of your position based on the current stock price, volatility, and date. You might also see other stock prices—or “slices”—plus and minus 10% from the current price. And for each of those slices, you’ll see the greeks of your positions calculated for both the higher and lower stock prices.

3—Next, look in the right-hand corner of the Position and Simulated Trades section for the Date field. That’s the date the models on the Analyze page use to determine the number of days until the options’ expiration. The expiration dates are fixed in the future, so by changing that date on the Analyze page you can simulate a different number of days to expiration. By default, it’s set to the current day. However, you can adjust to any date in the future you want. You’ll see the greeks in the Price Slices section, as well as the profit/loss graph on the Risk Profile change to reflect the new date.

You can also see what the greeks would be at a different stock price by adjusting the prices in the Price Slices section.

You can either click on the price and type directly over it, use the up/down arrows, or click on the drop-down arrow of the “Offset” and select a different value. You can also click the Add Slice or Set Slices buttons and have the price slices set to a percentage higher or lower, or a number of standard deviations higher or lower.

The Pictures—Risk Profile

Now, if the numbers confuse you and you prefer pretty pictures instead, switch from the Add Simulated Trades page to the Risk Profile page. By default, the Risk Profile shows you the profit/loss graph of your position. But instead, you can display the individual greeks (see Figure 4).

Click on where it says “P/L OPEN” at the top of the Risk Profile, and select one of the greeks from the drop-down menu. That shows the values of that greek for your position across a range of stock prices.

Change the date in the right-hand side of the Positions and Simulated Trades section, and it will change the date used to calculate the greeks on the Risk Profile, in addition to the ones in the Price Slice section.

3—HOW TO ANALYZE YOUR POSITION AFTER EXPIRATION

Question: I have options that are approaching expiration and are currently close to being in the money. I also have positions in further expirations. How can I see what my position will look like after expiration if the near-term options are in the money (or not)?

Answer: When stock-settled options are in the money at expiration, they deliver long or short stock, depending on the position. Long calls and short puts deliver long stock. Short calls and long puts deliver short stock. But if the current stock price is at a point where it’s hard to tell if the options will be in the money at expiration, you don’t know what the position’s
delta, for example, will be after expiration. Maybe you’ll have stock, maybe you won’t. And the deltas from the stock can have a big impact on the risk of your position. Have no fear: the Analyze page has you covered.

1— See Figure 5. Click the wrench icon on the right-hand side of the Positions and Simulated Trades section.

2— Click the arrow to the left of “More” in the middle. That displays the options’ expiration dates in your position.

3— Look for the Exercise Price for each expiration, which is the current stock price by default. The Exercise Price is the stock price the Analyze page uses to determine whether to evaluate your expiring options as stock (in the money) or nothing (out of the money) at expiration. You can set a different Exercise Price for each expiration in your position, creating the stock price’s simulated “path.”

4— If you advance the date on the right-hand side of the Positions and Simulated Trades section to a day past the expiration date of any of your options, you can see the impact of the Exercise Price.

Figure 5 shows a shot taken on 1/27/14 of the “future” P/L of Feb (near-term) and Mar put vertical spreads where the stock finished in the money the first trading day after expiration of the Feb options (2/24/14). With the stock in the money at $780. The P/L reflects a loss of $3,000 on the remaining position.

WELL, WE MADE IT THROUGH WITHOUT A SCRATCH. And even though we didn’t explore every corner of the Analyze page, you know enough to click on a few buttons yourself and feel certain you won’t be dinner for a band of tigers.

Important Information
For more information on the risks of investing and options, see page 43, #1-2.
Why do Treasury bond futures have weird tick sizes? I can understand a $1 tick value, or $10, or $25, or some easy to add-and-subtract number like that. But $31.25? One tick in a 30-year Treasury bond future (symbol: /ZB on the thinkorswim® platform) has a $31.25 dollar value. $31.25 comes from the days when everything—futures and stocks—traded in fractions of points. Stocks used to trade in 1/16 increments, which is a relic of the old Spanish “pieces of eight.” Bond prices traded in finer increments. Half of 1/16 is 1/32. 32 ticks still represent a full point in bond futures, even though stock prices have moved to full decimalization, because the face value of Treasury bonds is $1,000, $1,000 divided by 32 = $31.25.

I know I can buy stocks on margin and put up 50% of the shares’ value. I can do the math on that. But how do they come up with the margin requirements for futures?

A futures margin (the amount of money you have to put up to control a futures contract) is considered a performance bond against potential losses. Larger, more volatile futures contracts have higher margin requirements because of larger potential losses. For example, /ZB Treasury bond futures have an initial margin of about $2,700. /ES E-mini S&P 500 futures have an initial margin of about $4,500. The initial margins are related to the contract size and estimated volatility of the future, and are determined by a +/- price change. The futures exchanges determine a one-day likely maximum price change, and multiply that by the size of the futures contract to get the margin requirement. Individual brokers/dealers can have higher margin requirements than the exchange minimums.

What’s the contract size of a future?

A futures-contract size is the amount of the product that the future represents. It’s almost always a fixed number, and tries to be a useful and practical amount for hedgers and speculators in that product. For example, an oil future represents 1,000 barrels of oil. One corn future represents 5,000 bushels of corn. The E-mini S&P future represents $50 times the price of the S&P 500.

In my account I trade stocks and stock options, but I can’t trade futures. I can see the futures quotes on the thinkorswim® platform, but why can’t I enter an order? Brokerage accounts are regulated by specific government agencies and industry groups. The SEC and FINRA regulate trading in stocks, stock options, ETFs, and mutual funds. All those things are associated with stocks (i.e. equities). Futures and futures options are different. They’re regulated by the Commodity Futures Trading Commission, or CFTC. The goal of the CFTC is very similar to that of the SEC and FINRA, and basically encourages the efficiency of the futures markets, ensures their financial integrity, and protects participants against fraud, price manipulation, and abusive practices.

So, futures and futures options are traded and held in futures accounts separate from stocks and stock options. You can in fact trade futures and futures options at TD Ameritrade. (See the option chain in the bottom of Figure 1 above.) You just need to open up a futures account (subject to TD Ameritrade approval). It only takes a few minutes to apply, and there are no additional costs or fees to open a futures account. Once the account has been approved and funded, you can begin trading. But here’s the cool thing—the powerful technology behind the thinkorswim platform makes your futures account visible using the same log in as your TD Ameritrade equity account. All told, you can see your stock, stock option, futures, and futures-options positions in one place, and route orders from the same platform.

FIGURE 1: Familiar Face Futures trading is nearly identical on thinkorswim as its option and stock-trading counterparts. But learning the nuances of futures is crucial. For illustrative purposes only.
Opportunities in Up and Down markets

Whether you are looking to go long in the gold market or short the S&P 500, futures allow traders to access markets when and where they want, responding to changing conditions regardless of market direction. In addition, futures trading combines fast execution and accurate reporting to trade effectively in volatile economic times.

Diversity the products you trade. Express your true market opinion using contracts covering all major asset classes. When you include leverage, hedging opportunities, and tax benefits, it’s easy to see why sophisticated traders utilize futures contracts to maximize profit potential and help reduce risk associated with trading.

Explore more at tda.futuresnewstoday.com
J.P. Morgan was once asked what the stock market will do and he famously replied: “It will fluctuate.” Let’s face it, the market is hardly predictable. But here’s one thing we can bank on: once every quarter, publicly traded U.S. companies by law must report their financial status, more commonly known as earnings announcements. And these releases produce some interesting situations in options.

FIRST, THE CONUNDRUM
Like any other commodity, options are influenced by supply and demand. And earnings announcements are one of those events that can create demand for options, meaning some investors are more likely to buy rather than sell them. Here’s why: first, stocks can make big moves on the back of headlines, so some investors buy options (calls, puts, or a combination of both depending on the forecast) to make a leveraged bet. Second, when investors own a stock that’s about to report earnings, they may want to buy a put option to protect their position in case the stock tanks (buying a put locks in the right to sell the stock at a set price for a set period of time).

This excess demand can drive up prices, so option buyers have to be mindful of cost. Another factor that affects option prices is time to expiration. The further out you go the more an option costs, so around earnings, many traders tend to go with the shortest time frame they can. As recently as a few years ago, traders were limited to options that expired on a monthly basis. If you were bullish and purchased the $185 call option instead of the weekly option, you’d lose all of your investment.

ENTER WEEKLYS
Luckily, the options market has adapted to this dilemma by creating weekly options. For certain stocks, options are listed with their expirations each week, for five weeks out, in addition to regular monthly expiration cycles. Weeklys give option buyers the flexibility to better control the outlay for a given strategy.

Using a recent example (Figure 1), a certain new entrant in the auto sector reported earnings after the market closed. Looking at the option chain of XYZ in Figure 1, suppose an investor owned 100 shares but was worried about a disappointing report. Buying a $175 strike put would give them the right to sell the stock at $175, no matter how low it went. Notice the cost differences: $9.20 for the Weeklys (plus commissions and fees), $10.45 for the monthly November expiration, and $15.00 for the December expiration. Since the protective put was only needed for a short time (to get through the earnings news), the weekly option offered a cheaper alternative to the regular monthly options. Incidentally this protective put would have come in handy because the report was disappointing, and stock prices dropped from $176.81 to $151.16 (and actually fell near $120 a few weeks later). On the flip side, if the report were stellar, and the stock took off, and the put expired worthless, you’d lose all of your investment.

Or suppose you were bullish and purchased the $185 call option. Again, doing the price comparison shows $6.50 for the Weeklys, $7.70 for November expiration, and $12.20 for December. Every extra dollar paid moves the trade’s breakeven point higher, meaning the stock has to go up even more to compensate. Now, bear in mind, because they’re short-lived, you need to watch Weeklys closely. Volatility can be significant. And if the stock move is less than the effect of volatility, your profit could suffer a “volatility crush,” thereby turning your gains into losses.

Buying options around earnings announcements can be a tricky game but weekly options can help give traders the ability to buy only the time they need. Now, can we get a better answer to that age-old question that J.P. Morgan so eloquently dodged?

Important Information
For more information on the risks of the strategies discussed in this article, see page 43, #1 & 3.

Investools, Inc. and TD Ameritrade, Inc., are separate but affiliated companies and are not responsible for each other’s services, policies or commentary. Investools® does not provide financial advice and is not in the business of transacting trades. For more information, see page 9, #2.

For more information on transaction costs, see page 9, #3.
FROM OUR EXPERTS TO YOUR INBOX: OPTION ADVICE YOU CAN ACTUALLY USE.

The RED Option advisory service applies your choice of strategies to make option trade recommendations. We send those recommendations to your inbox. You make the trade, or if you are a qualified TD Ameritrade client, you can elect to have TD Ameritrade do it for you automatically. It’s easy—and RED Option provides knowledgeable trade advice paired with comprehensive option education.

When you subscribe, you can take advantage of:

- Opening, adjusting, and closing trade recommendations based on your choice of nine risk-defined option trade strategies
- An inside look at the step-by-step analytical methods that veteran floor traders apply when making trade recommendations
- The free Autotrade* feature, available to TD Ameritrade clients, which allows TD Ameritrade to act on a third-party newsletter recommendation by placing a trade on your behalf to your designated account

To learn more about RED Option, call 877-733-6786 or visit redoption.com today.

RED OPTION™

*Autotrade is a service of TD Ameritrade, Inc., available to select TD Ameritrade accounts at no additional fee. All trades initiated via Autotrade are subject to your individual commission rates and fees as a TD Ameritrade client. Please contact a TD Ameritrade Option Specialist at 800-669-3900 for more information, including eligibility requirements.

**When the two free months have passed, keep the service for just $20 per strategy per month.

Options are not suitable for all investors as the special risks inherent to option trading may expose investors to potentially rapid and substantial losses. Option trading privileges in a TD Ameritrade account subject to TD Ameritrade review and approval. Before trading options, carefully read Characteristics and Risks of Standardized Options. Contact TD Ameritrade at 800-669-3900 or your broker for a copy. RED Option Advisors, Inc. and TD Ameritrade, Inc. (member FINRA/SIPC/NFA) are separate but affiliated firms. Advisory services are provided exclusively by RED Option Advisors, Inc., and brokerage services are provided exclusively by TD Ameritrade, Inc. A subscription to RED Option Advisors will include a monthly fee. Please contact RED Option at 877-733-6786 for more information, including eligibility requirements. © 2012 TD Ameritrade IP Company, Inc.
The Token Glossary
• Terms you might stumble across in this issue.
• tdameritrade.com

Implied volatility
• The market’s perception of the future volatility of the underlying security, directly reflected in an option’s premium. Implied volatility, is an annualized number expressed in percent (such as 25%), is forward-looking, and can change.

Greeks
• THEORETICAL VALUES THAT HELP MEASURE THE FUTURE VALUE OF AN OPTION AFTER SOMETHING HAPPENS, SUCH AS TIME PASSING, VOLATILITY FLUCTUATING, OR DIRECTION CHANGING. THEY TAKE UNCERTAIN VARIABLES AND ATTEMPT TO QUANTIFY THEIR IMPACT, THEREBY ALLOWING YOU TO “STRESS-TEST” YOUR OWN OPTION STRATEGY. THE FOUR MOST COMMON GREEKS ARE DELTA, GAMMA, VEGA, AND THETA.

DELTA
• A measure of an option’s sensitivity to a $1 change in the underlying asset.

GAMMA
• A measure of what an option’s delta is expected to change per $1 move in the underlying.

VEGA
• A measure of an option’s sensitivity to a 1% change in implied volatility.

Theta
• A measure of an option’s sensitivity to time passing one calendar day.

Open Interest
• THE TOTAL NUMBER OF UNCLOSED OPTIONS OR FUTURES CONTRACTS THAT DAY.

Short Put Vertical
• A defined-risk, bullish spread strategy, composed of an equal number of short (sold) and long (bought) puts in which the credit from the short strike is greater than the debit of the long strike, resulting in a net credit taken into the trader’s account at the onset. The risk in this strategy is typically limited to the difference between the strikes less the received credit. The trade is profitable when it can be closed at a debit for less than the credit received. Breakeven is subtracting the credit received from the higher (short) put strike.

Vertical Spread
• A defined-risk, directional spread strategy, composed of a long and a short option of the same type (i.e. calls or puts). Long verticals are purchased for a debit, while short verticals are sold for a credit at the onset of the trade. Long call and short put verticals are bullish, whereas long put and short call verticals are bearish. The risk of a long vertical is typically limited to the debit of the trade, while the risk in the short vertical is typically limited to the difference between the short and long strikes, less the credit. Credit from the call.

Spread
• An option position or order that contains two or more option “legs,” which typically includes at least one short and one long position.

Implied volatility
• An option whose premium contains “real” value, i.e. not just time value. For calls, it’s any strike lower than the price of the underlying equity. For puts, it’s any strike that’s higher.

OUT OF THE MONEY
• An option whose premium is not only all “time” value, but the strike is away from the underlying equity. For calls, it’s any strike higher than the underlying. For puts, it’s any strike that’s lower.

IN THE MONEY
• An option whose premium contains “real” value, i.e. not just time value. For calls, it’s any strike lower than the price of the underlying equity. For puts, it’s any strike that’s higher.

Implied volatility
• THE MARKET’S PERCEPTION OF THE FUTURE VOLATILITY OF THE UNDERLYING SECURITY, DIRECTLY REFLECTED IN AN OPTION’S PREMIUM. IMPLIED VOLATILITY, IS AN ANNUALIZED NUMBER EXPRESSED IN PERCENT (SUCH AS 25%), IS FORWARD-LOOKING, AND CAN CHANGE.
1/ GENERAL DISCLAIMER
The information contained in this article is not intended to be investment advice and is for illustrative purposes only. Be sure to understand all risks involved with each strategy, including commission costs, before attempting to place any trade. Clients must consider all relevant risk factors, including their own personal financial situations, before trading. Past performance of a security or strategy does not guarantee future results or success. Transaction costs (commissions and other fees) are important factors and should be considered when evaluating any options trade. Options involve risk and are not suitable for all investors. Supporting documentation for any claims, comparisons, statistics, or other technical data will be supplied upon request. It is not possible to invest directly in an index.

2/ OPTIONS STRATEGIES
Trading options involves unique risks and is not suitable for all investors. Mini-options do not reduce the per share cost or price of options.

The long put strategy provides only temporary protection from a decline in the price of the corresponding stock. Should the long put position expire worthless, the entire cost of the put position would be lost.

A long call option position places the entire cost of the option position at risk. Should an individual long call position expire worthless, the entire cost of the position would be lost.

Spreads, condors, butterflies, straddles, and other complex, multiple-leg option strategies can entail substantial transaction costs, including multiple commissions, which may impact any potential return. These are advanced option strategies and often involve greater risk, and more complex risk, than basic options trades. Be aware that assignment on short option strategies discussed in this article could lead to unwanted long or short positions on the underlying security.

The naked put strategy includes a high risk of purchasing the corresponding stock at the strike price when the market price of the stock will likely be lower. Naked option strategies involve the highest amount of risk and are only appropriate for traders with the highest risk tolerance.

Naked option strategies involve the highest amount of risk and are only appropriate for traders with the highest risk tolerance.

The risk of loss on an uncovered call option position is potentially unlimited since there is no limit to the price increase of the underlying security.

Option writing as an investment strategy is absolutely inappropriate for anyone who does not fully understand the nature and extent of the risks involved.

A covered call strategy can limit the upside potential of the underlying stock position, as the stock would likely be called away in the event of substantial stock price increase. Additionally, any downside protection provided to the related stock position is limited to the premium received. (Short options can be assigned at any time up to expiration regardless of the in-the-money amount.)

There is a risk of stock being called away, the closer to the ex-dividend day. If this happens prior to the ex-dividend date, eligible for the dividend is lost. Income generated is at risk should the position moves against the investor, if the investor later buys the call back at a higher price. The investor can also lose the stock position if assigned.

The maximum risk of a covered call position is the cost of the stock, less the premium received for the call, plus all transaction costs.

Rolling strategies can entail substantial transaction costs, including multiple commissions, which may impact any potential return. You are responsible for all orders entered in your self-directed account.

Supporting documentation for any claims, comparisons, statistics, or other technical data will be supplied upon request.

3/ FUTURES
Probability analysis results are theoretical in nature, not guaranteed, and do not reflect any degree of certainty of an event occurring. The probability projections in the Analyze page assume the underlying stocks follow a lognormal distribution. The results are derived using the Black-Scholes formula for delta, consisting of the current stock price, number of days in the future, current volatility of the stock, and the risk-free rate of return.
Swipe, drag, and tap your way through the market.

Our mobile trading apps are optimized for the iPad®.

**TD Ameritrade Mobile**
This easy-to-use app is packed with trading essentials and innovative functionality. Place trades, discover potential investments with Snapstock™, and access enhanced third-party research.

**TD Ameritrade Mobile Trader**
Act on your most sophisticated trading strategies with this technologically advanced app. Trade equities, multi-leg options, futures, and forex; view live, streaming international CNBC feeds and premium video content from tastytrade®,* and test-drive theories with paperMoney®.

*TD Ameritrade and tastytrade, Inc. are separate, unaffiliated companies. TD Ameritrade is not responsible for any third-party content or opinions presented.

iPad® is a registered trademark of Apple, Inc.

The paperMoney software application is for educational purposes only. Successful virtual trading during a one-time period does not guarantee successful investing of actual funds during a later time period—market conditions change constantly.

Market volatility, volume, and system availability may delay account access and trade executions.

The risk of loss in trading securities, options, futures, and forex can be substantial. Clients must consider all relevant risk factors, including their own personal financial situation, before trading. Option, futures, and/or forex trading privileges subject to TD Ameritrade review and approval. Not all account owners will qualify. Futures and forex accounts are not protected by the Securities Investor Protection Corporation (SIPC).

TD Ameritrade, Inc., member FINRA/SIPC/NFA. TD Ameritrade is a trademark jointly owned by TD Ameritrade IP Company, Inc. and The Toronto-Dominion Bank. © 2013 TD Ameritrade IP Company, Inc. All rights reserved. Used with permission.